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Chapter 1: Introduction
HEAT (Harmonically Enhanced Algorithm 
Technology) is a software option that adds “an-
alog color” to Pro Tools® HD software with Avid 
HDX and Pro Tools|HD hardware. 

HEAT is applied to all active audio tracks in 
your session, emulating magnetic recording 
tape combined with harmonic coloration com-
monly experienced with analog mixing consoles. 
Use HEAT to open up your mixes with warm, 
analog-modeled soft-saturated distortion.

System Requirements and 
Compatibility
To use HEAT, you need the following:

• An iLok USB Smart Key

• An iLok.com account for managing iLok 
licenses

• Pro Tools HD software with one of the 
following hardware configurations:

• A qualified Avid HDX system

– or –

• A qualified Pro Tools|HD system

• DVD drive (if installing from disc)

• Internet access for software activation and 
registration purposes
Avid can only assure compatibility and provide 
support for hardware and software it has tested 
and approved. 

For complete system requirements and a list of 
qualified computers, operating systems, hard 
drives, and third-party devices, visit:

www.avid.com/compatibility

Registration
Your software purchase is automatically regis-
tered when you activate your iLok license (see 
“Authorizing Software” on page 3).

Registered users are eligible to receive software 
update and upgrade notices. 

For information on technical support, visit 
www.avid.com.

HEAT is supported with Pro Tools HD 8.1 
and higher with Pro Tools|HD hardware, or 
with Pro Tools HD 10.0.x and higher with 
Avid HDX hardware.
Chapter 1: Introduction 1
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Conventions Used in This 
Guide
All of our guides use the following conventions 
to indicate menu choices and key commands:
:

The names of Commands, Options, and Settings 
that appear on-screen are in a different font.

The following symbols are used to highlight 
important information:

Convention Action

File > Save Choose Save from the 
File menu

Control+N Hold down the Control key 
and press the N key

Control-click Hold down the Control key 
and click the mouse button

Right-click Click with the right 
mouse button

User Tips are helpful hints for getting the 
most from your system.

Important Notices include information that 
could affect your data or the performance of 
your system.

Shortcuts show you useful keyboard or 
mouse shortcuts.

Cross References point to related sections in 
this guide and other Pro Tools guides.
HEAT Option Guide
About www.avid.com
The Avid website (www.avid.com) is your best 
online source for information to help you get the 
most out of your Pro Tools system. The follow-
ing are just a few of the services and features 
available. 

Product Registration Register your purchase 
online. 

Support and Downloads Contact Avid Customer 
Success (technical support); download software 
updates and the latest online manuals; browse 
the Compatibility documents for system 
requirements; search the online Knowledge Base 
or join the worldwide Pro Tools community on 
the User Conference. 

Training and Education Study on your own using 
courses available online or find out how you can 
learn in a classroom setting at a certified 
Pro Tools training center. 

Products and Developers Learn about Avid 
products; download demo software or learn 
about our Development Partners and their 
plug-ins, applications, and hardware. 

News and Events Get the latest news from Avid 
or sign up for a Pro Tools demo.



Chapter 2: Installation and Authorization
Installing HEAT
To install HEAT:

1  Do one of the following:

• Purchase and download the installer for 
your computer platform from the online 
Avid Store (www.avid.com). After down-
loading, make sure the installer is uncom-
pressed (.dmg on Mac or .ZIP on Windows).

• Use the HEAT Installer disc included with 
boxed versions of HEAT. Insert the disk 
into your computer.

• Use the Pro Tools Installation disc that 
came with your version of Pro Tools. Insert 
the disc into your computer.

2  Locate and double-click the installer icon:

• On Mac, Install HEAT.mpkg 

– or –

• On Windows, HEAT Setup.exe 

3  Follow the on­screen instructions.

4  When prompted, click Install.

5  Complete the installation, following the on-
screen instructions.
Authorizing Software
HEAT is authorized using the iLok USB Smart 
Key (iLok), manufactured by PACE Anti-Piracy.

This key can hold hundreds of licenses for all of 
your iLok-enabled software. Once an iLok is au-
thorized for a given piece of software, you can 
use the iLok to authorize that software on any 
computer.

Authorizing Downloaded 
Software
If you downloaded software from the Avid Store 
(http://shop.avid.com), you authorize it by 
downloading a license from iLok.com to an 
iLok. 

iLok USB Smart Key

An iLok USB Smart Key is not supplied with 
plug-ins or software options. You can use the 
iLok included with certain Pro Tools systems, 
or purchase one separately.

For more information, visit the iLok website 
(www.iLok.com).
Chapter 2: Installation and Authorization 3
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Authorizing Boxed Versions of 
Software
If you purchased a boxed version of software, it 
comes with an Activation Code (on the included 
Activation Card).

To authorize software using an Activation Code:

1  If you do not have an iLok.com account, visit 
www.iLok.com and sign up for an account.

2  Transfer the license for your software to your 
iLok.com account by doing the following:

• Visit www.avid.com/activation.

– and –

• Input your Activation Code (listed on your 
Activation Card) and your iLok.com User 
ID. Your iLok.com User ID is the name you 
create for your iLok.com account.

3  Transfer the licenses from your iLok.com ac-
count to your iLok USB Smart Key by doing the 
following:

• Insert the iLok into an available USB port 
on your computer.

• Go to www.iLok.com and log in.

• Follow the on-screen instructions for trans-
ferring your licences to your iLok.

4  Launch Pro Tools.

5  If you have any unauthorized software 
installed, you are prompted to authorize it.
Follow the on-screen instructions to complete 
the authorization process.

For more information, visit the iLok website 
(www.iLok.com).
HEAT Option Guide
Removing HEAT
If you need to remove HEAT from your 
Pro Tools system, follow the instructions below 
for your computer platform.

Mac OS X

To remove HEAT:

1  Locate the HEAT plug-in file on your Startup 
drive. Its location depends on the type of hard-
ware you are using, as follows:

• For Pro Tools|HD systems: Library
/Application Support/Digidesign/
Plug-Ins/HEAT.dpm

– or –

• For Avid HDX systems: Library/
Application Support/Avid/Audio/
Plug-Ins/HEAT.aaxplugin

2  Drag the HEAT.dpm or HEAT.aaxplugin file to 
the Trash.

3  Empty the Trash.

Windows

To remove HEAT:

1  Choose Start > Control Panel.

2  Under Programs and Features.

3  Select the HEAT option from the list of 
installed applications.

4  Click Uninstall.

5  Follow the on-screen instructions to remove 
HEAT.



Chapter 3: Using HEAT
When enabled, HEAT is applied to all active au-
dio tracks in your session, emulating the effect 
of an analog mixing console. HEAT is supported 
with all mono, stereo, and surround formats. 
Use HEAT to open up your mixes with warm, an-
alog-modeled soft-saturated distortion.

Enabling HEAT
When HEAT is enabled, it uses DSP resources on 
all active audio tracks. This is important to 
know because as you increase (or decrease) the 
number of audio tracks in the session, you also 
increase (or decrease) the amount of DSP re-
sources required to keep HEAT hot. Note that 
HEAT does not use DSP resources on inactive 
audio tracks.

To enable (or disable) HEAT in a session, do one of 
the following:

Select (or deselect) Options > Activate HEAT.

– or –

Select (or deselect) the HEAT On/Off button 
in the Mix window in HEAT view.

You can also enable the Enable HEAT in New 
Sessions option in the Pro Tools Preferences to 
have HEAT automatically enabled for all new 
sessions.

To enable (or disable) HEAT for new sessions:

1  Choose Setup > Preferences.

2  Click the Processing tab.
3  In the DSP Management section, select (or de-
select) the Enable HEAT in New Sessions option.

4  Click OK.

About HEAT Processing
HEAT provides global controls for Drive and 
Tone. These affect all audio tracks where HEAT 
is not bypassed.

Drive
The Drive control introduces non-linear pro-
cessing that emulates magnetic recording tape 
combined with harmonic information com-
monly found in analog gear. 

Turning the Drive control counter-clockwise 
emulates tape-based non-linear distortion. As 
with tape, increasing the Drive control level by 
turning it counter-clockwise increases har-
monic content by adding higher frequency odd 
harmonics (starting with the 3rd and 5th har-
monics). HEAT also emulates the recording and 
reproduction equalizers of tape decks that fur-
ther modifies the harmonic content. As a result, 
when turning the Drive control counter-clock-
wise, HEAT fattens up the bottom and mid-
range of the processed audio and smooths high-
frequency transients as you increase the 
processing. 
Chapter 3: Using HEAT 5
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Turning the Drive control clockwise has a more 
aggressive effect, adding an even harmonic se-
ries commonly found in triode tube circuits to 
the odd harmonic series. This can give the effect 
of prized tube microphones and other tube 
based analog gear. 

Note that the harmonic structure changes with 
signal level and the amount of processing being 
applied, just like it does with vacuum tubes in 
the analog world.

Tone
As with tape, there can be loss of high frequen-
cies with respect to low frequencies if driven far 
enough, as the high frequencies start compress-
ing sooner than the low frequencies. HEAT can 
compensate for these losses, adding more detail 
and some brightness too, depending on the pro-
gram material and its level. Moving the Tone 
control away from its default position accentu-
ates (clockwise) or de-accentuates (counter-
clockwise) the amount of detail and brightness.

The effect of the Tone control is different, de-
pending on the Drive control setting. The 
amount and character of the harmonic content 
is changed by this control, in a non-linear fash-
ion, unlike what a tone control in an equalizer 
would do.

HEAT Processing
With HEAT processing, the peaks in the signal 
are being reduced while the low level harmonic 
content is increased, thus reducing the level of 
existing peaks. Think of it as a tube or tape do-
ing soft clipping, “squashing” the peaks and 
causing analog compression over a wide dy-
namic range.
HEAT Option Guide
How Much Processing Should I Use?

HEAT processing is level and program depen-
dent. Although a general setting usually works 
for many sources, some settings that work best 
for one source may not have the desired effect 
for another source. If you need a general pur-
pose setting try adding two steps of the Drive 
control (in either direction).

Since your ears may not be used to the changes 
to the harmonic content that HEAT provides, 
you may need to spend a little time listening to 
the effect of HEAT processing on your program 
material to acclimate yourself. The human ear 
loves a little harmonic generation. Experiment 
with the settings to discover what sounds best to 
you. 

Once you are used to how the program material 
sounds with some HEAT processing, disabling 
HEAT can highlight the subtle yet significant ef-
fect of HEAT on your program material.

The amount of processing can result in subtle 
changes or drastic changes depending on what 
the program is like, and how it was recorded. 
The difference between processing an analog or 
digital recording can be subtle or drastic. It may 
be easier to hear the effect of the processing in 
material that is more “open,” as opposed to ma-
terial that is more dense. The amount of low fre-
quency information added also affects how you 
hear the processing.

HEAT Controls
HEAT provides a simple set of master controls 
for the tuning the color of the effect, and a set of 
controls for each audio track in your session.



HEAT Master Controls
The HEAT Master controls let you adjust the 
amount and color of HEAT processing for all au-
dio tracks. Take some time to experiment with 
different settings until you get the desired tone 
color for your mix.

On/Off (HEAT) Enables (or disables) HEAT in 
your Pro Tools session.

Bypass (BYPASS) Bypasses HEAT processing 
without disabling it. Note that bypassing HEAT 
does not free up the DSP resources needed for 
HEAT.

Meter Displays the average amount of HEAT 
processing across all audio tracks.

Drive Adjusts the amount of Drive for HEAT, 
which emulates the distortion you get when 
overdriving an analog channel strip on a con-
sole. At the default 12 o’clock position, no HEAT 
processing is applied. Turn the knob counter-
clockwise to add odd harmonics to the mix (a 
magnetic tape saturation–like effect). Turn the 
knob clockwise to add even harmonics to the 
odd harmonic series for the effect of simulating 
a triode tube circuit.

Tone Adjust the Tone (bass to treble) for HEAT. 
Turn the control to the right for a brighter 
sound and to the left for a darker sound.

HEAT Master controls
Showing and Hiding HEAT Master 
Controls

HEAT Master controls can be viewed in the Mix 
window. 

To show (or hide) HEAT Master controls:

Click the Show/Hide HEAT View button in the 
lower right corner of the Mix window.

HEAT Track Controls
HEAT track controls are available on all audio 
tracks. HEAT only affects audio tracks.

Bypass (BYP) Bypasses HEAT processing for the 
individual audio track. Note that bypassing 
HEAT on individual tracks does not free up the 
DSP resources used by HEAT for that track.

Pre/Post Insert (PRE) Sets HEAT processing to 
be Pre or Post inserts on the individual track. 
HEAT processing is Pre Inserts when the PRE 
button is lit.

Meter Displays the amount of HEAT processing 
on the individual audio track. On multichannel 
tracks, the meter shows the average amount of 
HEAT applied to all channels of that track.

Show/Hide HEAT Master View button in the Mix 
window

HEAT Track controls
Chapter 3: Using HEAT 7
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Showing and Hiding HEAT Track 
Controls

HEAT Track controls can be viewed in the Mix 
window. 

To show (or hide) HEAT Track controls, do one of 
the following:

Select (or deselect) View > Mix Window Views > 
HEAT.

– or –

Select (or deselect) HEAT in the Mix Window 
View selector.

Master Bypass and Track 
Bypass Indicators
The Track Bypass button is color coded to indi-
cate whether or not HEAT is explicitly (or im-
plicitly) bypassed when Master Bypass is en-
abled. Explicitly bypassed tracks remain 
bypassed when disabling the Master Bypass.

Selecting HEAT in the Mix Window View selector
HEAT Option Guide
When a track is explicitly bypassed, the BYP 
button is bright orange.

When the Master Bypass is enabled, it is bright 
orange and any explicitly bypassed track BYP 
buttons also remain bright orange. For any im-
plicitly bypassed track, the BYP button changes 
to dark orange.

A Note About Other Track 
Types
HEAT only affects audio tracks. It is not applied 
to Instrument, Auxiliary Input, or Master 
tracks. If you are using virtual instrument plug-
ins on an Instrument or Auxiliary Input track 
and want to apply HEAT, you can either bus re-
cord audio from that track to an audio track, or 
you can bus the output of the track to the input 
of an audio track and enable Input monitoring.

DSP and Voice Requirements
The amount of DSP resources used by HEAT is 
based on the number of voices used for audio 
tracks, the type of DSP hardware, and the ses-
sion sample rate.

The following table lists the number of mono 
audio tracks per DSP chip that are available with 
HEAT processing enabled. 

HEAT Track and Master controls

HEAT Track and Master controls



*The number of tracks available per chip is the 
same for both types of Accel chips (with SRAM and 
without RAM).

Stereo tracks require twice the DSP of mono 
tracks, and surround formats require as much 
DSP per channel as the corresponding number 
of mono tracks (for example, a 5.1 track uses the 
same amount of DSP as 6 mono tracks).

Insufficient DSP Resources
It is possible that your system may have insuffi-
cient DSP resources to add more audio tracks to 
the session when HEAT is enabled (because 
there is not enough DSP available for HEAT on 
the new tracks). Should this occur, Pro Tools 
prompts you to do one of the following:

• Create the new tracks, but make them inac-
tive. (Inactive audio tracks do not use any DSP 
resources.)

– or –

• Disable HEAT and create the new tracks.

When opening a session that was saved with 
HEAT enabled, but your system does not have 
enough DSP to apply HEAT to all active audio 
tracks in the session, HEAT is automatically dis-
abled. The session notes dialog will indicate that 
HEAT has been made inactive.

Available number of mono audio tracks per DSP chip

DSP Chip 
Type

44.1/ 
48 kHz

88.2/ 
96 kHz

172.4/ 
192 kHz

HDX 86 42 19

HD Accel* 30 14 6

HD (non- 
Accel)

12 5 2
Once the session is open, you can manage which 
tracks you want to have active with HEAT en-
abled within the DSP limitations of your system. 
You can also expand your Avid HDX or 
Pro Tools|HD system with additional cards to 
increase the available DSP resources for HEAT.

In some cases, if the session you are opening has 
a lot of active DSP (TDM) plug-ins, the session 
may open with HEAT enabled, but make some of 
the session’s DSP plug-ins inactive. This is be-
cause HEAT processing takes priority over DSP 
plug-in processing.

Voice Requirements
When enabling HEAT, extra voices are required 
to make HEAT active if HEAT is set to Pre insert 
on a track and the first plug-in on that track is 
an RTAS plug-in. If there are an insufficient 
number of voices available, HEAT cannot be ac-
tivated.

If HEAT is already active, set to Post insert on a 
track, and an RTAS plug-in is the first plug-in 
on that track, HEAT will require extra voices to 
be changed to Pre insert. If there are an insuffi-
cient number of voices available, the Pre button 
will be inactive until you increase the number of 
voices (in the Playback Engine) or until more 
voices are made available (such as by making 
some audio tracks inactive).
Chapter 3: Using HEAT 9
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Using HEAT with a 
Worksurface
(ICON and C|24 Only)

You can use the following features provided on 
ICON (D-Control and D-Command) and C|24 to 
control HEAT. 

D-Control and D-Command
With D-Control or D-Command, you can access 
HEAT Master Controls in the Custom Fader sec-
tion, and HEAT channel controls directly from 
the channel strips. 

Master Controls

HEAT Master Controls include On/Off, Bypass, 
Drive, and Tone. 

To access HEAT Master Controls from D-Control 
or D-Command:

Shift+Control+Press the Plug-Ins switch in 
the Custom Fader section. 

HEAT creates a Custom Fader for HEAT and 
maps controls to the middle encoders as de-
scribed below. 

For information about using HEAT with 
Avid Artist and Pro Series Control Surfaces, 
see the Pro Tools EUCON Guide.
HEAT Option Guide
D-Control 

D-Control provides HEAT Master Controls 
within a single Custom Fader (#8)

D-Command (Custom Fader 7 and 8)

D-Command provides HEAT Master Controls in 
the encoder sections of two Custom Faders (7 
and 8). 

HEAT Master Controls on D-Control

Encoder Parameter Action

#3 HEAT (On/Off) Rotate the 
encoder, or 
press encoder 3 
BMP, to toggle

#4 MstByp (Master 
Bypass)

Rotate encoder, 
or press encoder 
4 BMP, to toggle

#5 Drive Rotate encoder

#6 Tone Rotate encoder

HEAT Master Controls on D-Control

Encoder Parameter Action

#1
(Fader 7)

HEAT (On/Off) Press BMP to 
toggle, or rotate 
the encoder

#2
(Fader 7

MstByp (Master 
Bypass)

Press BMP to 
toggle, or rotate 
the encoder

#1
(Fader 8)

Drive Rotate encoder

#2
(Fader 8)

Tone Rotate encoder



Channel HEAT Bypass and Pre/Post

When HEAT is enabled in a session, each chan-
nel strip provides HEAT Bypass and Pre/Post. 
You can access these channel settings directly 
from D-Control and D-Command channel 
strips. Channel HEAT controls follow Do To All 
and Do to All Selected modifiers. 

To access HEAT in the channel strip:

1  Make sure HEAT is enabled in the session. 

2  Shift+Control+Press the channel Inserts 
switch. 

D-Control

On D-Control , encoders/BMP switches 5 and 6 
map to HEAT Pre/Post and Bypass, respectively. 

To toggle a channel between (HEAT) Pre or Post 
Inserts: 

Do either of the following: 

• Rotate encoder 5

– or –

• Press encoder 5 BMP switch. 

To toggle a channel in or out of HEAT Bypass: 

Do either of the following: 

• Rotate encoder 6

– or –

• Press encoder 6 BMP switch. 

D-Command

On D-Command, both channel encoders and 
their BMP switches map to HEAT Pre/Post (up-
per encoder row) and Bypass (lower encoder 
row). 
To toggle a channel in or out of HEAT Bypass: 

Do either of the following: 

• Rotate the lower encoder.

– or –

• Press the lower encoder’s BMP switch. 

To toggle a channel between (HEAT) Pre or Post 
Inserts: 

Do either of the following: 

• Rotate the upper encoder.

– or –

• Press the upper encoder’s BMP switch. 

C|24
C|24 lets you adjust HEAT Master Controls from 
encoders 21–24, and HEAT channel controls in 
each channel strip. 

Master Controls

To access HEAT Master Controls on C|24: 

Press the Soft Keys switch in the Channel Bar. 
To exit, press the Soft Keys switch again.

HEAT Master Controls are mapped to the en-
coder and encoder switches of channel strips 
21–24, as shown in Table 1 on page 12.

HEAT supports Flip mode for both its Master 
and Channel controls. 
Chapter 3: Using HEAT 11
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Channel HEAT Bypass and Pre/Post

When HEAT is enabled in a session, each channel strip provides HEAT Bypass and Pre/Post. You can 
access these channel settings directly from C|24 channel strips. Channel HEAT controls follow Do To 
All and Do to All Selected modifiers. 

To access HEAT channel controls:

1  Make sure HEAT is enabled in the current session. 

2  In the channel strip, press and hold the channel Insert switch. To exit, press the same switch again.

To toggle a channel in or out of HEAT Bypass: 

Press the channel Bypass switch. 

To toggle a channel between (HEAT) Pre or Post Inserts: 

Rotate the channel encoder, or press the encoder switch, and choose Pre or Post.

Table 1. HEAT Master Controls on C|24

Encoder: 21 22 23 24

Parameter HEAT (On/Off) MstByp (Master 
Bypass)

Drive Tone

Action Press the Encoder 
switch to toggle

Press the Encoder 
switch to toggle

Rotate encoder Rotate 
encoder
HEAT Option Guide
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